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Abstract 

A new system for continuous flow chemiluminescence detection, based on the use of a simple and low-

priced lens-free digital camera (with Complementary Metal Oxide Semiconductors technology) as 

detector, is proposed for the quantitative determination of paracetamol in commercial pharmaceutical 

formulations. Through the camera software, AVI video files of the chemiluminescence emission are 

captured and then, using friendly ImageJ public domain software (from National Institutes for Health), 

properly processed in order to extract the analytical information. The calibration graph was found to be 

linear over the range 0.01-0.10 mg L-1 and over the range 1.0-100.0 mg L-1 of paracetamol, being the limit 

of detection of 10 µg L-1. No significative interferences were found. Paracetamol was determined in three 

different pharmaceutical formulations: Termalgin®, Efferalgan® and Gelocatil®. The obtained results 

compared well with those declared on the formulation label and with those obtained through the official 

analytical method of British Pharmacopoeia. 
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Introduction 
 

Chemiluminescence (CL) is usually defined as the production of electromagnetic radiation as a result of a 

chemical reaction. One of the reaction products is in an excited state and emits light on returning to its 

ground state. The process by which chemiluminescence is generated is the same as that for photolumi-

nescence (fluorescence and phosphorescence) except that the former requires no light excitation source. 

The analytical interest of CL lies in the ability to produce molecules that emit light without prior 

irradiation, which avoids problems arising from stray light, unselective excitation and instability of the 

light source. Moreover, the advantages of CL analysis include low limits of detection and a wide linear 

range. Analytical applications of liquid-phase chemiluminescence have increased considerably over the 

last three decades and, up to date, the analytical literature published a number of applications for the 

determination of both, inorganic and organic compounds in a variety of industrial, clinical, 

biotechnological and environmental matrices.  Chemiluminescence methods have been also frequently 

used in recent years for the analysis of pharmaceutical compounds [1-7]. 

Chemiluminescence is usually measured either in (a) static mode or (b) continuous-flow mode. In the 

first one, a syringe is employed to deliver portions of sample and chemiluminescent reagent(s), which are 

mixed in a cell housed in a luminometer chamber located in front of the detector window. From the 

obtained CL curve (variation of the chemiluminescence intensity with the reaction time), different 

parameters (height, area, profile width, decay rate) can be related to the analyte concentration. In the 

second mode, analyte and chemiluminescent reagent(s) are continuously flowing through different 

channels before merging (Fig. 1). Chemiluminescence intensity is then measured at a fixed position 

beyond the merging point, where a flow cell is placed in front of the detector window. The flow rates and 

the volume between the merging point and the flow cell position are the parameters which determine the 

reaction time and so the arising CL intensity [2]. 

Thus, the essential components of a flow chemiluminescence detection system are the reagent mixing 

chamber, the flow-cell, the photodetector (frequently a photomultiplier tube or PMT) and an electronic 

data acquisition and processing software. Many instruments designed for other purposes include all these 

components and can thus be used for chemiluminescence measurements. In fact and in order to measure 

CL emission intensity, it has been a common practice in analytical chemistry to use suitably modified 

ordinary instruments, such as a spectrofluorimeter, where the emission monochromator has been replaced 

with an appropriate device (a parabolic mirror) to reflect the whole emitted light by the CL reaction 

through the PMT. Moreover, CL measures can also be generally achieved with simple, robust and often 

home-made PMT based instrumentation [2, 6, 7]. 

Besides photomultiplier tubes, which are relatively expensive devices, other usually employed 

detection systems for CL are silicon photodiodes and in the last decades, the increasing technical 

improvement and affordability of digital image-based systems hardware and software, have promoted the 

use of charge-coupled devices (CCD) and complementary metal oxide semiconductors (CMOS) as 

suitable detectors in CL analytical methods as well as in other kinds of quantitative chemical analyses [8-

12]. 



Digital cameras capture images by means of CCD or more frequently CMOS sensors. Each cell (pixel 

or photosite) in a CCD or CMOS acts as a light-sensitive individual element providing an electrical 

response that can be digitized to build an optical image. A black and white (B&W) sensor consisting of 8-

bit pixels can respond to 28 = 256 levels of grey ranging from 0 (black) to 255 (white). This allows each 

pixel in a captured image to be assigned a numerical value from 0 to 255 (grey level or analytical signal) 

which can be subsequently used for analytical calibration. As a result, a digital image-based system can 

be used as a suitable analytical detector, since each captured image provides a vast amount of information 

[8-12]. 

Both technologies (CCD and CMOS) are intended for taking images digitally with several similarities 

and differences in the signal processing, performance and cost. Both are pixelated metal oxide 

semiconductors which convert light into electrical charge and then to electrical signals. The main 

difference is that each pixel of a CCD transfers charge as an analog signal to be converted to voltage 

outside the pixel, so it needs an external analog-to-digital converter, while a CMOS has its own charge-

to-voltage conversion system integrated within each pixel, being its output a digital signal. There has been 

debate among pros and cons of the two systems and until recent years CCD has been more widely 

adapted for use as detectors, perhaps owing to its earlier and more mature development. Nevertheless, 

although theoretically CCD images are superior, CMOS works faster and can be produced at cheaper rate. 

In fact, owing to its advantages over CCD, CMOS are being nowadays massively employed as detectors 

in all kind of digital image-based systems [9, 10]. 

There is an extensive market offer of such technology at very affordable prices and different types of 

commercial CCD or CMOS digital image-based systems such as digital cameras, mobile phone cameras, 

desktop scanners or even webcams have been described for use as an alternative detector unit for 

chemical or biochemical analysis systems, especially when analysis are based on colour changes [10]. 

The digital image-based detectors can replace the more expensive UV-VIS, fluorescence and 

chemiluminescence spectrophotometers. For instance, a webcam is a very common low cost CMOS based 

device broadly used in computer/internet applications and its application for immunoassay microplate 

reading or fluorescence detection has been yet reported, though so far the use of a webcam as an 

analytical detector is still infrequent [13, 14]. 

The analytical applications of the liquid-phase chemiluminescence have been [2] classified into (a) 

direct methods, those where the light emission arouses from the analyte oxidation and (b) indirect 

methods, those where the analyte usually playing a different role in the CL emission (e.g. reagent, 

catalyst, quencher, enhancer) and which involve well known chemiluminescence emitters, being luminol, 

acridinium salts, oxalate esters, dioxetanes and tris(2,2´-bipyridyl)ruthenium(II) the most usually 

employed reagents in this kind of analytical applications [1-7]. 

In liquid phase (aqueous solutions), luminol (5-amino-2,3-dihydrophthalazine-1,4-dione) is the most 

usually employed CL reagent [15]. Luminol reacts in alkaline solution with a strong oxidizing agent such 

as hydrogen peroxide, hexacyanoferrate (III), permanganate, N-bromosuccinimide or periodate in the 

presence of a catalyst (usually a metal or metal-containing compound or an enzyme). The redox reaction 

yields 3-aminophthalate in an excited electronic state, which returns to the ground state with the emission 

of visible light (CL) around 425nm. Luminol-based systems [1-7, 15] have been broadly exploited in the 



quantitative analysis of numerous compounds (including pharmaceuticals), because of its relatively high 

quantum efficiency (quantum yield) and susceptibility of its CL mechanism to a vast number of 

compounds. In fact, in luminol-based procedures, the analyte itself usually plays either as inhibitor or 

enhancer of the CL emission, making possible to correlate the analyte concentration vs the intensity of CL 

emission (analytical signal). 

Here we propose the development of new system of continuous-flow CL detection, for the 

quantitative determination of paracetamol in pharmaceutical formulations, based on the use of a simple 

and low-priced CMOS lens-free digital black and white camera.  

As far as the authors know, this is the first attempt to employ a lens-free imaging (CMOS) camera to 

monitor a chemiluminescent signal in a flow system by recording video to obtain the analytical signal and 

applying it to the quantitative determination of a drug substance (paracetamol) in commercial 

pharmaceutical formulations. 

 

Experimental 
 

Materials 

 

All reagents used were analytically pure. K3[Fe(CN)6], H2O2 (30% w/v; 100 vol.), NaOH, NH4Cl, NH3, 

Na2HPO4, Na2CO3, borax, ascorbic acid, citric acid anhydrous, sodium benzoate, sorbitol, sulphuric acid, 

hydrochloric acid, ammonium cerium sulphate and ferroin from Panreac (Castellar del Vallés, Barcelona, 

Spain). Acetylsalicylic acid, caffeine, hydroxypropyl methylcellulose, magnesium stearate, 

methocarbamol, microcrystalline cellulose, polyvinylpyrrolidone, saccharin, silicon dioxide, stearic acid, 

talc and wheat starch from Guinama (La Pobla de Vallbona, Valencia, Spain). Starch from Merck 

(Darmstadt, Germany). Codeine phosphate from Uquifa (Barcelona, Spain). Luminol from Fluka 

(nowadays Sigma-Aldrich: St. Louis, Missouri, USA). 

Solutions were prepared from water purified by reverse osmosis, de-ionized to 18 MΩ⋅cm with a 

Sybron/Barnstead Nanopure II water purification system furnished with a fibre filter of 0.2 μm pore size.  

The signal (AVI file) was taken with a Luna-QHY 5 lens-free digital B&W camera (equipped with a 

monochrome CMOS MT9M001 from Micron: Manassas, Virginia, USA), usually intended for 

astronomical purposes, from Lunático Astronomía: Torrelodones, Madrid, Spain 

(http://tienda.lunatico.es/). An integration time of 1000 ms and a gain of 50 were employed. The obtained 

CL signal was processed with the public domain software ImageJ (v 1.43g), Windows version, developed 

by the National Institutes for Health and available for free download at http://rsbweb.nih.gov/ij.  

The finally proposed flow manifold (Fig. 2) consisted of a peristaltic pump (Gilson Minipuls 2; 

Middleton, WI, USA) which pumped paracetamol (Flow-rate 1,  1.2 mL min-1 of paracetamol aqueous 

solution), hexacyanoferrate(III) (Flow-rate 2, 1.2 mL min-1 of 1.4 x 10-3 mol L-1 K3[Fe(CN)6] aqueous 

solution), hydrogen peroxide (Flow-rate 3, 2.0 mL min-1 of 1.0 x 10-2 mol L-1 H2O2 aqueous solution) and 

luminol (Flow-rate 4, 4.3 mL min-1 of 1.0 x 10-3 mol L-1 luminol and 0.1 mol L-1 NaOH solution) through 

PTFE tubes (0.8 mm internal diameter). Finally, all channels merged in a T shaped piece positioned 2 cm 

before entering the flow cell, which consists on a flat spiral-coiled quartz tube (1.0 mm internal diameter, 

http://tienda.lunatico.es/
http://rsbweb.nih.gov/ij


3 cm total diameter of the flow cell, without gaps between loops).  The flow cell was backed by a mirror 

for maximum light collection and placed 2 mm from the CMOS.  The T-piece, flow cell and camera were 

placed in a home-made, absolutely light-tight box.  The output was fed to a computer equipped with the 

specific software (QGSoftware) also supplied by Lunático Astronomía, Spain (http://tienda.lunatico.es/).  

 

Methods 

 

Each session work, a video file of the generated chemiluminescence was recorded through the CCD 

software and saved as a VideoFile.avi. 

All the obtained video files were processed with the software ImageJ. The processing sequence (4 

steps) was as follows (operation A>B>C means select command B on menu A and then select 

subcommand C in command B): 

1: File>Open>VideoFile.avi 

2: Edit>Selection>Select All 

3: Plugins>Stacks-T-functions>Intensity v Time Monitor>List 

4: File>Save as>Plot Values.xls 

The generated data (Plot Values.xls file) was finally imported into Microsoft Excel for statistical 

analysis. Bearing on mid the 8 bits nature of the CMOS, the signal was always comprised and so 

expressed between 0 (total inhibition) and 255 (maximum CL emission: no inhibition) arbitrary units 

(a.u.). 

The results were compared with those obtained through the official methods of British Pharmacopoeia 

[17]. The official procedure is based on the drug solution in sulphuric acid (1 mol L-1) followed by boiling 

(reflux) for 1 hour and a final titration (in HCl, 2 mol L-1) with ammonium cerium sulphate with ferroin 

as indicator. 

 

Results and discussion 

 
The main goal of the experimental work was the development of new system of continuous-flow CL 

detection, for the quantitative determination of paracetamol in pharmaceutical formulations, based on the 

use of a simple and low-priced CMOS lens-free digital black and white camera (initially intended to 

obtain telescopic astronomical images), which has the advantage of being even more robust and simpler 

than a webcam because it do not have optical systems in front of CMOS sensor, allowing to easily place 

the spiral CL flow cell in front of the detector. Through the camera software, a number of images per 

second are captured when the reagents reach the flow cell and the CL emission is produced and then, the 

obtained AVI video file is properly processed in order to extract the analytical information by using 

ImageJ, public domain software, designed and freely distributed by NIH, which yields the intensities 

(mean grey level) of each image (frame) in the captured video sequence. The data generated by means of 

ImageJ are then imported into Microsoft Excel (Microsoft, Redmond, WA) becoming the register of the 

CL analytical signal. 

http://tienda.lunatico.es/


The presented procedure is based on procedure published by one of the authors [16], where the 

chemiluminescence arising from the well-known chemiluminescent system luminol-H2O2-Fe(CN)6
3-, is 

employed. The method is based on the oxidation of paracetamol by hexacyanoferrate (III) and their 

subsequent inhibitory effect on the reaction between luminol and hydrogen peroxide (produced by de 

consumption of the hexacyanoferrate (III)), which allows relating the CL intensity (analytical signal) with 

the paracetamol (analyte) concentration. 

Bearing in mind that CL signal intensity is time-depending, all the work was performed, instead of in 

a batch mode, by means of a continuous flow manifold, where the time of measurement after mixing of 

solutions is accurately controlled by the flow rates.  

Instrumental parameters (Luna-QHY 5 CMOS based camera) were initially maintained in its native 

value, namely: Integration time, 1000 ms and Gain, 50. 

All experiments were conducted in the four-channel configuration of Fig. 2. This was the simplest 

continuous flow manifold that allowed individual solutions of the three reagents and the analyte to be 

used. Also, it ensured that the chemiluminescent reaction started after the last T-junction. In order to 

establish the conditions required to obtain nearly but not completely saturated chemiluminescence 

(maximum empirical intensity near but below 255 a.u. to be able to use a wide enough inhibition range on 

the y-axis), the study and optimization of chemical and continuous flow variables was performed by using 

a univariate method. 

 

Optimization of flow, chemical and CMOS parameters 

 

First and pumping deionized water by channel 1, we studied the effect of the concentrations of the three 

reagents (luminol, hexacyanoferrate (III) and hydrogen peroxide). Bearing in mind the former work [16], 

the concentrations were studied in the next intervals: luminol, 1.0 x 10-4 – 1.0 x 10-2 mol L-1 (in NaOH 

0.05 M); hexacyanoferrate (III), 1.0 x 10-3 – 1.0 x 10-1 mol L-1 and hydrogen peroxide, 1.0 x 10-4 – 1.0 x 

10-2 mol L-1. The concentrations adopted were: 1.0 x 10-3 mol L-1 luminol (in NaOH 0.05 M); 1.0 x 10-2 

mol L-1 of hydrogen peroxide (see Fig. 3a) and, in order to obtain nearly but not completely saturated 

chemiluminescence, 1.4 x 10-3 mol L-1 hexacyanoferrate (III) (see Fig. 3b).  

The influence of the pH and the nature of alkaline media employed to dissolve luminol was then 

studied between pH 8.91 and 12.35 by using NH4Cl/NH3 (pH from 8.91 to 10.05), Borax/NaOH (pH from 

9.52 to 11.20), Na2HPO4/NaOH (pH from 11.25 to 11.72) and NaOH (pH 12.35), being NaOH the 

medium which yield the maximum signal and thus selected for further work (Fig. 4). 

The NaOH concentration was then optimized by studying values comprised over the range 0.05 – 0.25 

mol L-1 (measured pH between 11.51 and 12.71, respectively). The highest useful analytical signal 

(higher concentrations saturated the detector response with analytical signal over 255 a.u.) was obtained 

at pH 12.50 (NaOH 0.1 mol L-1), which was chosen for subsequent experiments. 

Then flow rates were optimized by studying values of the variables over the range 1 – 4.5 mL min-1. 

Attending to the maximum analytical signal, the chosen conditions were Q1 = Q2 = 1.2 mL min-1; Q3 = 2.0 

mL min-1; Q4 = 4.3 mL min-1 which yield a signal of 251 a.u. 



Next, the influence of paracetamol concentration over the CL signal (inhibition) was tested at 

concentrations ranging from 0.01 to 100 mg L-1. The first one showed an inhibition of 4 a.u. whereas 100 

mg L-1 showed an inhibition of 235 a.u. 

The influence of the reactor lengths on the paracetamol oxidation rate (See Fig. 2, L1 and L2) were 

then studied over the range = 10 – 150 cm. Testing different paracetamol concentrations ranging from 

0.01 to 100 mg L-1, no differences were observed, showing that at the previously established flow rates, 

the reactor lengths have no influence over the reaction rate. So, initial values of L1= L2 = 50 cm were 

maintained. 

Once continuous flow variables were optimized, chemical variables were re-optimized. Significant 

differences were not observed so chemical variables were maintained in the previously optimized values. 

Finally, the influence of instrumental parameters was also studied. Different values of the integration 

time and gain of the CMOS camera were tested in the ranges 0 – 5000 ms and 0 – 100, respectively. 

Obviously, to obtain the same value of CL signal, high gain values needed shorter integration times; 

however, the signal had higher noise, being 3% the RSD of the blank signal. On the other hand, longer 

integration times needed lower gain, and the noise was lower (RSD of the blank signal, 0.1%); 

nevertheless, at lower gain values, low concentrations of paracetamol (below 0.1 mg L-1) were not 

detected. Consequently, an integration time of 1000 ms and a gain of 55 were finally selected as the best 

compromise between signal noise (RSD of the blank signal, 0.3%) and a lower limit of detection. 

  



Analytical figures of merit. 

 

Limit of Detection 

 

Considering the inhibition of the CL emission (Ih, in arbitrary units, a.u.) as the analytical signal, the limit 

of detection was empirically determined by testing diluted solutions of paracetamol until 10 µg L-1, which 

was experimentally confirmed as the concentration yielding a signal (2.8 a.u.) higher than the 

corresponding to the blank (0.0 a.u.) more three times the standard deviation of the blank (0.8 a.u.). The 

obtained limit of detection (10 µg L-1) shows that it is possible to detect paracetamol even in very diluted 

samples. 

 

Calibration graph 

 

The calibration graph was found to be linear over the range 0.01 – 0.10 mg L-1 and over the range 1.0 – 

100.0 mg L-1 of paracetamol concentration (Fig. 5). For the first range, the regression equation was Log 

(Ih) = 1.82 + 0.690 Log(C) (where C is the paracetamol concentration in mg L-1) and the correlation 

coefficient (N=5) was 0.9999. For the second range, the regression equation was Log (Ih) = 1.70 + 0.270 

Log(C) (where C is the paracetamol concentration in mg L-1) and the correlation coefficient (N=5) was 

0.9995.  Double logarithmic scale was employed in order to obtain a linear relation between Ih and C. 

The obtained correlation coefficients (both higher than 0.999) show a good linear behaviour in both 

studied paracetamol concentration ranges. 

 

Reproducibility 

 

The between day reproducibility study was performed working each day (5 days) with freshly prepared 

solutions, being the paracetamol concentrations (five values for each range) comprised in the range 0.01 – 

0.10 mg L-1 and the range 1.0 – 100.0 mg L-1. For the first range, the mean (N=5) slope obtained was 

0.686, with an RSD of 4.1% and mean correlation coefficient of 0.9970 (RSD of 0.8%). For the second 

range, the mean (N=5) slope obtained was 0.282, with an RSD of 2.2% and mean correlation coefficient 

of 0.9993 (RSD of 0.3%).  

 

Foreign compounds 

 

The influence of foreign compounds and excipients that may be found in pharmaceutical formulations 

containing paracetamol was also studied. Synthetic solutions containing 1.0 mg L-1 of the analyte and 

different amounts of foreign substances (up to 100 mg L-1 or saturated solution) were measured. The 

relative errors (%) were calculated by comparing the analytical signal with that obtained by testing a 

solution of pure paracetamol at the same concentration (1.0 mg L-1).  The obtained results are depicted in 

Table 1.  The obtained data shows no significant influence of the studied foreign compounds; therefore, 



the proposed method shows a relevant selectivity and can be used for the determination of paracetamol in 

samples containing those compounds, without previous separation steps. 

 

Assay of real samples 

 

Paracetamol was determined in three different pharmaceutical formulations:  

 

Termalgin® (tablets, from NOVARTIS): paracetamol 500 mg. 

Efferalgan® (tablets, from BRYSTOL-MYERS SQUIBB): paracetamol 500 mg. 

Gelocatil® (tablets, from GELOS): paracetamol 650 mg. 

 

The results (average of three determinations) were compared with those declared on the formulation 

label and with those obtained through the official methods of British Pharmacopoeia [17]. The official 

procedure is based on the drug titration with ammonium cerium sulphate with ferroin as indicator. Table 2 

shows the obtained results (average recovery ± 95 % CI and % RSD); it is possible to affirm that the 

proposed method provides good results, perfectly comparable with those declared by the manufacturers 

and with those obtained with the official method (the proposed method yields even better results than the 

official one, especially for the Gelocatil formulation). 

 

Conclusions 
 

A low-priced device like CMOS lens-free digital B&W camera, specifically intended for astronomical 

imaging purpose, shows to be useful to detect and to measure CL emission intensity. The proposed 

camera has the advantage of being more robust and simpler than other kind of digital devices, because it 

do not have optical systems in front of CMOS sensor, allowing to easily place the spiral CL flow cell in 

front of the detector. The fundamental handicap could be the relatively low sensitivity of the CMOS 

sensor (versus PMTs or cooled CCDs), which only could be used to measure CL arising from high 

quantum yield systems. Nevertheless, bearing in mind the vast number of applications of such systems [1-

7, 15] there are a lot of potential uses of CMOS sensors in chemiluminescence detection. 

Moreover, in this case, the performance of the new proposed method compares very well with the 

previous one [16] bearing on mind that there, the calibration graph inhibition-concentration was found to 

be linear over the range 2.5-12.5 mgL-1 of paracetamol (correlation coefficient of 0.997, N=6) and the 

limit of detection was 2.1 mgL-1 of analyte. 

Through the camera software, AVI video files of the CL emission are captured and then, using 

friendly ImageJ public domain software (by NIH), properly processed in order to extract the analytical 

information. The data generated by means of ImageJ are then imported into Microsoft Excel (Microsoft, 

Redmond, WA) becoming the register of the CL analytical signal. 

In addition to competitive accuracy, precision and sensitivity, the new proposed procedure shows a 

relevant selectivity which allows analysing the proposed samples without separation steps of the 

chromatography-based methods. The obtained results for the tested pharmaceuticals, compares well with 



those declared by the manufacturer and with the obtained by the official (BP) method and it could be 

emphasized than the proposed method yields better results than the official one, especially for the 

Gelocatil formulation.  On the other hand, the new procedure, opposite to the titrimetric official 

procedure, has all the advantages arising from continuous flow methodology and could be easily exported 

to other continuous flow analytical methodologies like FIA, SIA or HPLC.  

Finally, it could be emphasized that the proposed method can be especially advantageous for scenarios 

where available resources for analytical equipment investments are scant. 

 

Competing interests 

 

The authors declare that they have no competing interests. 

 

 

References 
 

1. Worsfold PJ, Robards K. Analytical applications of liquid phase chemiluminescence.  Anal 

Chim Acta. 1992; 266: 147-173. doi:10.1016/0003-2670(92)85040-D. 

2. Fuster Mestre Y, Lahuerta-Zamora L, Martínez Calatayud J. Flow-chemiluminescence: a 

growing modality of pharmaceutical analysis.  Luminescence. 2001; 16(3): 213-235. 

doi: 10.1002/bio.608. 

3. Roda A, Pasini P, Mirasoli M, Michelini E, Guardigli M. Biotechnological applications of 

bioluminescence and chemiluminescence. TRENDS Biotechnol. 2004; 22 (6): 295-303. 

doi:10.1016/j.tibtech.2004.03.011. 

4. Yinhuan, L., Weifen, N. and Jiuru, L.  Talanta 71 (2007) 1124-1129. 

5. Gámiz-Gracia L, García-Campaña AM, Huertas-Pérez JF, Lara FJ. Chemiluminescence 

detection in liquid chromatography: Applications to clinical, pharmaceutical, environmental and 

food analysis—A review. Anal Chim Acta. 2009; 640 (1-2): 7-28. 

doi:10.1016/j.aca.2009.03.017. 

6. Roda A, Guardigli M. Analytical chemiluminescence and bioluminescence: latest achievements 

and new horizons. Anal Bioanal Chem. 2012; 402: 69–76. doi: 10.1007/s00216-011-5455-8. 

7. Iranifam M. Revisiting flow-chemiluminescence techniques: pharmaceutical analysis. 

Luminescence. 2012; 28 (6): 798–820. doi: 10.1002/bio.2441. 

8. Byrne L, Barker J, Pennarun-Thomas G, Diamond D. Digital imaging as a detector for generic 

analytical measurements. TrAC–Trend Anal Chem. 2000; 19: 517–522. doi: 10.1016/S0165-

9936(00)00019-4. 

9. Rodrigues ERGO, Lapa RAS. CMOS arrays as chemiluminescence detectors on microfluidic 

devices. Anal Bioanal Chem. 2010; 397: 381–388. doi: 10.1007/s00216-010-3518-x. 

10. Capitán-Vallvey LF, López-Ruiz N, Martínez-Olmos A, Erenas MM, Palma AJ. Anal Chim 

Acta. 2015; 899: 23–56. doi:10.1016/j.aca.2015.10.009. 



11. Lahuerta-Zamora L, Alemán López PA, Antón Fos GM, Martín Algarra R, Mellado-Romero 

AM, Martínez Calatayud J. Quantitative colorimetric-imaging analysis of nickel in iron 

meteorites. Talanta. 2011; 83(5): 1575-1579. doi:10.1016/j.talanta.2010.11.058. 

12. Lahuerta-Zamora L, Pérez Gracia T. Using digital photography to implement the McFarland 

method. J. R. Soc. Interface. 2012; 9: 1892–1897. doi:10.1098/rsif.2011.0809. 

13. Wongwilai W, Lapanantnoppakhun S, Grudpan S, Grudpan K. Webcam camera as a detector for 

a simple lab-on-chip time based approach. Talanta. 2010; 81: 1137–1141. doi: 

10.1016/j.talanta.2010.01.058.  

14. Balsam J, Bruck HA, Kostov Y, Rasooly A. Image stacking approach to increase sensitivity of 

fluorescence detection using a low cost complementary metal-oxide-semiconductor (CMOS) 

webcam. Sens Actuators B Chem. 2012: 171– 172: 141– 147. doi:  10.1016/j.snb.2012.02.003. 

15. Marquette CA, Blum LJ. Applications of the luminol chemiluminescent reaction in analytical 

chemistry. Anal Bioanal Chem. 2006; 385: 546–554. doi: 10.1007/s00216-006-0439-9. 

16. Gregorio Alapont A, Lahuerta-Zamora L, Martı́nez Calatayud J. Indirect determination of 

paracetamol in pharmaceutical formulations by inhibition of the system luminol–H2O2–

Fe(CN)6
3− chemiluminescence. J Pharm Biomed Anal. 1999; 21: 311–317. doi: 10.1016/s0731-

7085(99)00124-7. 

17. British Pharmacopoeia 1993, HM Stationery Office, London, 1993, vol. II, p. 1043. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 
 

Fig. 1 Position of observation window relative to emission-time curve for flow-through 

chemiluminescence measurements. Hatched region under the curve represents the 

detected portion of the emission. 
  



 

 
 

 

Fig. 2 Proposed continuous flow assembly for paracetamol determination. (See text). 

1, paracetamol (1.2 mL min-1 of paracetamol aqueous solution); 2, hexacyanoferrate 

(III) (1.2 mL min-1 of 1.4 x 10-3 mol L-1 K3[Fe(CN)6] aqueous solution); 3, hydrogen 

peroxide (2.0 mL min-1 of 1.0 x 10-2 mol L-1 H2O2 aqueous solution); 4, luminol (4.3 

mL min-1 of 1.0 x 10-3 mol L-1 luminol and 0.1 mol L-1 NaOH solution); 5, peristaltic 

pump; 6, light-tight box  containing the spiral flow cell and the CMOS camera; 7, 

computer and 8, waste. 
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Fig. 3a  Influence of luminol and hydrogen peroxide concentrations. Luminol: Series1, 

0.0001 mol L-1; Series2, 0.0005 mol L-1; Series3, 0.001 mol L-1; Series4, 0.005 mol L-1; 

Series5, 0.01 mol L-1. Hydrogen peroxide concentrations: 0.1 mol L-1, 0.01 mol L-1 and 

0.001 mol L-1. Hexacyanoferrate (III) concentration was maintained at 0.001 mol L-1 in 

the five series. 
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Fig. 3b Influence of hexacyanoferrate(III) concentration. Luminol 0.001 mol L-1; 

Hydrogen peroxide 0.01 mol L-1. 
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Fig. 4 Influence of pH. 
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Fig. 5 Calibration graphs over the range (a) 0.01 – 0.10 mg L-1  

and (b) 1.0 – 100.0 mg L-1 of paracetamol concentration. 
 

 

 

 

 

 

LOG(Ih) = 0,690 LOG(C) + 1,82 

0.4

0.5

0.6

0.7

0.8

0.9

1

1.1

1.2

-2 -1.8 -1.6 -1.4 -1.2 -1

LO
G

(Ih
) /

 a
.u

. 

LOG(C) / mg L-1 

(a) 

LOG(Ih) = 0,270 LOG(C) + 1,70 

1.6

1.7

1.8

1.9

2

2.1

2.2

2.3

0 0.5 1 1.5 2

LO
G

(Ih
) /

 a
.u

. 

LOG(C) / mg L-1 

(b) 



 

 

Table 1 Influence of foreign compounds. All solutions containing 1.0 mg L-1 of paracetamol. 

Foreign compound C / mg L-1  Er / % 

Acetylsalicylic acid 100 0.0 

Ascorbic acid 5.0 -3.5 

Caffeine 100 -1.3 

Citric acid anhydrous 100 0.1 

Codeine Phosphate 100 0.0 

Hydroxypropyl methylcellulose Saturated solution 0.0 

Magnesium stearate Saturated solution 0.0 

Methocarbamol 100 -0.6 

Microcrystalline cellulose Saturated solution 0.0 

Polyvinylpyrrolidone 100 -0.2 

Saccharin 100 1.5 

Silicon dioxide Saturated solution 0.0 

Sodium benzoate 100 0.4 

Sodium carbonate 100 0.0 

Sorbitol 100 0.3 

Starch Saturated solution 0.0 

Stearic acid Saturated solution 0.1 

Talc Saturated solution 0.0 

Wheat starch Saturated solution 0.2 

 

 

 

 

 



 

 

Table 2 Tested pharmaceutical formulations. 

*Average recovery (of three determinations) ± 95 % CI and precision (% RSD). 

Pharmaceutical  

Formulation 

Label claim  

per tablet / mg 

Official BP method found 

 amount* per tablet / mg 

 

Proposed method found 

 amount* per tablet / mg 

 

Termalgin® 500 504 ± 5 (95 % CI) (0.4 % RSD) 500 ± 5 (95 % CI) (0.4 % RSD) 

Efferalgan® 500 510 ± 5 (95 % CI) (0.4 % RSD) 503 ± 5 (95 % CI) (0.4 % RSD) 

Gelocatil® 650 679 ± 7 (95 % CI) (0.4 % RSD) 658 ± 7 (95 % CI) (0.4 % RSD) 

 

 

 


